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iMovie Tutorial
Through the use of easy-to-follow movies, step-by-step
instructions, and helpful tips, you’ll learn the basics of
iMovie.
When you make a movie, you tell a story. That story is
made up of scenes, which are made up of video clips.
With iMovie, you can easily arrange your clips in the
order that best tells your story. To change the story,
you can simply cut out parts you don’t like, rearrange
the order of your clips, or both. It’s that easy.
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Moving Video from the Camera to Your Mac

After you capture great footage with your video camera, you’re ready to make a
movie. First you’ll need to connect your video camera to your Mac, and then
copy footage from the camera into iMovie HD, a process known as importing.
iMovie makes importing easy. When you import video into an iMovie project, it
automatically divides your video into individual clips, making it easy to edit. And
with the Magic iMovie feature iMovie HD automatically organizes your clips and
adds transitions, titles, and music. You get a complete movie with the click of a
button.

Moving Video from the Camera to Your Mac
Copyright © 2005 Apple Inc. All rights reserved.

http://www.apple.com/support/imovie/tutorial/imovieTutorial_print.html

Page 3 of 52

iMovie Tutorial

http://www.apple.com/support/imovie/tutorial/imovieTutorial_print.html

08/21/2007 02:24 PM

Page 4 of 52

iMovie Tutorial

08/21/2007 02:24 PM

Learning Center

Try It

Moving Video from the Camera to Your Mac
Import video from your video camera to iMovie HD
Use a FireWire cable to connect your video camera to the FireWire port on your
Mac, then turn on your camera.

Click the iMovie HD icon in the Dock.

Create a new project by clicking the Create Project button or by going to the File
menu and then choosing New Project.

In the window that appears, type a name for your project. Notice that iMovie HD
automatically saves your project in the Movies folder on your hard disk.

Click the Create button.

Use the playback controls in iMovie HD to rewind to where you want to start
importing.
Click the Import button.

Watch as the clips appear in the iMovie HD Clips pane.

When you’re finished importing, click the Import button again.

Save your project by opening the File menu and choosing Save Project.

Moving Video from the Camera to Your Mac
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Moving Video from the Camera to Your Mac
Let iMovie HD automatically create a movie for you
If you’re in a hurry you can make a Magic iMovie and automate your editing. You just
plug in your video camera and iMovie HD automatically imports and sequentially
arranges your video in the timeline. You’ll select the titles, transitions and the soundtrack,
and let iMovie HD do the rest.
Monitor the amount of hard disk space remaining
Digital video clips use a large amount of hard disk space. For example, five minutes of
DV footage uses approximately 1GB of space. The same amount of HD video can
occupy between 2GB to 4GB depending on the format. If you have limited hard disk
space, import and edit your video in sections instead of trying to do so all at once. You
can see how much space remains on your hard disk by using the monitor located in the
lower-right corner of the iMovie window.
iMovie HD automatically supports different video formats
iMovie automatically understands what type of video you’re importing from your video
camera. iMovie HD supports DV and HD files. You can choose MPEG-4 if you’re working
with video imported from a phone or PDA, or even iSight format if you’re recording with
your Apple iSight.
What you need to make a high-definition video with iMovie
High definition video is quickly becoming the format you see broadcast on TV. An HD
camera stores more pixels than a standard definition camera, letting you see more crisp
detail in your video footage. iMovie supports editing with HD video footage (HDV 720p
and 1080i), so you can make movies just like the pros.
Importing video from an MPEG-4 camera
You can use many digital still cameras, PDAs and cell phones to record short videos.
MPEG-4 is a standard compression that is used to significantly reduce the file size of
video. When you attach cameras, PDAs and cell phones to your Mac you’ll see them
appear as a volumes on your desktop. Just open the volume and drag the movie right to
the iMovie clips pane in your project.
Importing video from your iSight camera
You can use your iSight camera to record video directly into your iMovie project. This
means you can spontaneously add clips to your project while you’re working on it. Just
connect your iSight camera to the FireWire port of your Mac and you’re ready to start
recording. Because iMovie HD supports the iSight file format, you don’t have to wait for
your footage to be converted.
Import directly to the iMovie timeline
You can import footage directly from your video camera to the iMovie timeline rather than
to the Clips pane. This is a quick and easy way to get your footage into your iMovie
http://www.apple.com/support/imovie/tutorial/imovieTutorial_print.html
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project. You can then edit right in the timeline. Go to the iMovie HD menu, choose
Preferences, click the Import tab and then choose to place clips in the Movie Timeline.
If you’re importing video that is already edited
Instead of importing your video as separate clips, you can set iMovie HD to import your
video as a single clip. This may be useful if you’re importing a movie that you’ve already
edited and you just want to change a small portion. Go to the iMovie HD menu, choose
Preferences, click the Import tab and then deselect the “Start new clip at each scene
break” option.
Moving Video from the Camera to Your Mac
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Arranging Your Clips

After you’ve imported your clips, you can arrange them for your movie. To
include a clip in the movie, drag it from the Clips pane to the clip viewer at the
bottom of the window. How you order your clips will help tell your story.
When you play your movie, the clips will appear as you arranged them in the
timeline. If you don’t like how your movie looks, simply rearrange the clips in the
clip viewer. Remember, the order in which you filmed your video doesn’t have to
be the order in which you present your movie.

Arranging Your Clips
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Arranging Your Clips
Set the order of your clips
Select a clip in the iMovie Clips pane.

Drag it to the clip viewer at the bottom of the iMovie window.

Repeat this process with the other clips you want to include.

Move the clips in the clip viewer to change the order in which they appear in your
movie.

Click the Rewind button to move the playhead to the beginning of your movie,
and then click the Play button to watch your movie.

Save your iMovie project.

Arranging Your Clips
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Arranging Your Clips
Delete clips you don’t want to use
After you decide which clips you want to use in your iMovie project, you’ll want to delete
any unused clips. This helps keep your project organized and reclaim hard disk space.
To delete unused clips drag them to the iMovie trash or select the clips and then press
the Delete key. The clips stay in the iMovie trash, and can be retrieved, until you empty
the trash.
Easily move clips around
There are a few different ways you can move clips around in iMovie HD. You can drag
imported clips from the clips pane to the timeline or drag and rearrange clips within the
Timeline view (just like you can in the Clips view). To select and move multiple clips just
hold down the Shift or Command keys while selecting the clips you want to move.
Split a clip into multiple clips
If you have a really long clip with no scene break, and you want to break it into several
sections, it’s easy to create multiple clips. Just move the playhead to where you want to
split the clip, go to the Edit menu and then choose Split Video Clip at Playhead.
Compare the lengths of your movie’s clips
To view a clip’s length relative to the length of other clips in the movie, click the Timeline
Viewer button in the iMovie window. The clips appear as long narrow boxes along with
the tracks for any music you’ve added. You can use the Zoom slider in this view to
change the size of the boxes that represent the clips.
Carefully consider how you arrange your clips
When creating your movie, think about how you want to arrange your clips. Consider
mixing wide shots with close-ups; adding a shot that sets the location (known as an
establishing shot) before showing close-ups; and including similar shots at the beginning
and end of your movie, which provides a sense of closure. Be creative and have fun;
your audience will appreciate it.
Arranging Your Clips
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Keeping Only the Parts You Want

Good editing is part of what makes a great movie great. Editing long clips helps
keep your story going, and makes the movie interesting for your audience. With
iMovie HD, you can easily edit out the parts of a clip you don’t want.
In the iMovie timeline view you’ll see a clip’s length relative to the length of the
other clips in the movie. To edit a clip so that it only shows the part you want,
simply drag the ends of the clips in toward the center.

Keeping Only the Parts You Want
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Keeping Only the Parts You Want
Edit clips in the timeline view
Click the Timeline Viewer button in the iMovie window.
Select a clip from the iMovie timeline.

Move your pointer to near the end of the clip and notice the pointer change to two
arrows. This means you can trim your clip.
Drag your pointer toward the center of the clip and notice that the duration of
your clip shortens as you move further to the left. You can see the new ending
point in the clip viewer.
Stop dragging when you find exactly the frame you want to end your clip. Notice
the right edge of your clip now displays a straight edge rather than rounded
corners indicating an edit has been made.
If you change your mind and want to restore the clip to a longer duration, simply
drag the edge to the right.

Repeat this process with the other end of the clip.
Save your iMovie project.

Keeping Only the Parts You Want
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Keeping Only the Parts You Want
View waveforms when you use direct trimming with audio
When you want to be precise with your audio editing in the timeline, go to the View menu
and then select Show Audio Waveforms. This way, when you edit in the timeline you can
see exactly where your sound starts and stops, and even see where the beats occur.
Ripple your clips down the timeline
In the timeline view, position your pointer in the center of a clip, click, and then drag your
mouse to the right. All of the clips in the timeline, beginning with the clip you selected,
move to the right, leaving a gap in the timeline. You can fill this gap with another clip, a
photo, or even a title.
Change two clips at once
You can use direct trimming to edit the ending point of one clip and the beginning point
of the next clip. Hold down the Command key as you drag from the center of one clip
toward the next clip, effectively trimming the adjacent clip.
Add color clips in your movie
With iMovie HD, you can create clips in the timeline that don’t contain video footage, but
fill the frame with black or a color. This can help you create interesting transitions and
give you dramatic backgrounds for titles. In the timeline, simply drag a clip from the
center to the right to insert space before your clip. Switch to Clip view and notice a black
clip appears before your selected clip. To change the color, just double-click the clip. In
the window that appears, you can set the clip’s color and duration.
Cropping and deleting portions of a clip
Besides direct trimming, you can precisely select which parts of your clips you want to
show in your movie by using Crop or Clear. Select a portion of a clip in the clip viewer by
dragging the crop markers below the scrubber bar to indicate where you want your clip to
begin and end. Next, go to the Edit menu and then choose Crop or Clear to remove a
section. You can use the arrow keys on your keyboard to move frame by frame through
your footage, or hold down the shift key while pressing the arrow key to move 10 frames
at a time.
Trimmed portions of clips are never deleted
When you use direct trimming, the unused portions of your clip is simply rolled up
underneath your clip so you can always unroll the footage back out if you change your
mind about which footage you want to use.
Easily undo changes you made
You want to work fluidly with your footage to create a great movie. Sometimes you might
make a few edits and decide you don’t like them. With iMovie HD you can undo as many
changes as you want. Simply choose Undo from the Edit menu as many times as you
want between saves.
http://www.apple.com/support/imovie/tutorial/imovieTutorial_print.html
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Creating a Title for Your Movie

You’ve created a great movie. Now it needs an equally great title. iMovie HD
comes with many title styles, all of which you can customize by changing the
size, font, or color of the title’s text. You can even set your title to fly in from offscreen.
With iMovie HD, you can add one or more titles to any part of your movie. You
can also add captions, and even create scrolling credits for the end of your
movie. You have the option to set titles over video, still pictures, or a solid
background.

Creating a Title for Your Movie
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Creating a Title for Your Movie
Add a title to the beginning of your movie
Click the first clip in the clip viewer, and then click the Titles button.
Click a title to select it, and then type your title in the text entry fields.

Use the options to change the color, style, and size of the title text.
Click the Preview button to see what the title will look like in your movie.

Make sure the Over Black option is deselected so that the title appears over the
first clip.
Drag the title from the list to the left of the first clip in the clip viewer. Notice the
small red line appear below the clip. It appears while the title is being added to
the clip.
After the red line disappears, click Rewind to move to the beginning of your
movie, then click the Play to watch the movie.

Save your iMovie project.

Creating a Title for Your Movie
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Creating a Title for Your Movie
Set titles to appear over a black background
Instead of setting your titles to appear over a clip, you can set them to appear over a
black background. This technique is often used for titles at the beginning of a movie and
for credits at the end. Click the “Over black” checkbox in the Titles pane before you drag
the title to the clip viewer.
Adjust the speed of a title
With iMovie, you can adjust how fast titles appear and how long they stay onscreen by
using the Speed and Pause sliders in the Titles pane. Remember to leave your titles
onscreen long enough for your audience to read them.
Are you going to show your movie on a television?
Some televisions reduce the amount of viewing area for your movie. To prevent titles
from being cut off when the movie is displayed on a television, select the QT Margins
checkbox in the Titles pane before dragging the title to a clip. This will ensure your
audience will be able to see your entire title, no matter what television they have.
Use titles creatively
Titles are useful for more than just the beginning and ending of your movie. You can use
a title to show the passage of time. Consider titles such as “Meanwhile back at home” or
“Two weeks later.” You can even use titles to list the names of the people in your movie,
which you’ll find helpful when you watch your movie years later.
Place videos and still images inside your title text
The Clip to Characters title feature lets you create titles with special effects where you
can see through your titles to display animated gradients, motion images, video clips and
more. Try varying the kind of footage you place behind your title. For example, use black
and white footage, clips with lots of effects, or even still images that move out of the
frame to discover some really interesting title effects.
Creating a Title for Your Movie
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Using Digital Pictures in Your Movie

Whether you’re on vacation or at home in the backyard, sometimes you’ll want to
capture events with your video camera, and other times you’ll want to take
pictures with your digital camera. And sometimes you’ll want to do both. Wouldn’t
it be great if you could combine your best video and your favorite digital
pictures? With iMovie HD, you can.
With iMovie HD, you can access pictures in iPhoto and easily add them to your
movie. You can even drag pictures from anywhere on your hard disk right to the
iMovie HD timeline.

Using Digital Pictures in Your Movie
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Using Digital Pictures in Your Movie
Add digital pictures to your iMovie HD project
Make sure that you have pictures stored in iPhoto.

In iMovie HD, click the Photos button. Notice your digital pictures appear in the
Photos pane.
Use the arrows to scroll through all the pictures in your library.

Select the picture you want to add, and then deselect the Ken Burns Effect. This
turns off motion effects.
Drag the photo to the clip viewer. The small red progress indicator appears as
iMovie HD adds the picture.
After the red line disappears, click Rewind to move to the beginning of your
movie, then click Play to watch the movie.
Save your iMovie project.

Using Digital Pictures in Your Movie
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Using Digital Pictures in Your Movie
Organize your pictures ahead of time
If you plan to include lots of digital pictures in your movie, you may want to organize
them first. In iPhoto, create a new album, and then add the pictures in the order in which
you want them to appear in your movie. In the iMovie Photos pane, choose the album
from the Photo Library pop-up menu.
Make a still image from a video clip
You may have a poor-quality video clip that contains one great image. With iMovie, you
can easily turn any frame of a video clip into a five-second still image to use in your
movie. Simply move the playhead to the image in the clip, go to the Edit menu, and
choose Create Still Frame. Your new still clip appears in the Clips pane. If you want to
adjust how long the still image appears in your movie, double-click the clip and then
change the clip length in the window that appears.
Change the length of a digital picture
To increase or decrease how long a picture appears in the movie, use the Duration slider
at the top of the Photos pane, and then click Apply.
Scanning your old photographs
You’re not limited to using only digital photos in your movie. Consider scanning your old
pictures and including them. For example, you could scan your parents’ wedding pictures
to use in a video you make for their wedding anniversary.
Drag photos directly from iPhoto into the iMovie clips pane
You can also search your iPhoto Photo Library to easily find just the right picture for your
movie. When you locate the picture you want, drag it from iPhoto to the iMovie HD clips
pane or the timeline.
Importing video clips you took using your digital camera
Many digital cameras let you take short video clips. This can be useful if you’re at an
event without your video camera. When you import your photos into iPhoto, these
movies will also become part of your Photo Library. You can then drag these movie clips
to your iMovie project and edit them, just like the footage you take with your video
camera.
Use iPhoto to resize your digital pictures to match your HD video footage
With an image in iPhoto, go to Edit mode, and then choose Custom from the Crop popup menu in the bottom toolbar. In the window that appears enter 16 and then 9 in the
fields. This will constrain the crop tool to a 16:9 ratio–the same as used in your HD
footage. This way, you can take advantage of the great editing tools in iPhoto, and your
photo will be available for use in your iMovie project.
Use the Ken Burns Effect in iMovie HD to crop your pitures to match your
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widescreen footage
Within iMovie HD, when your project is set as HDV or DV Widescreen, the Photos pane
is pre-set for 16:9 aspect ratio allowing you can crop a photo to the same aspect ratio of
your video footage.
Using Digital Pictures in Your Movie
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Adding Transitions Between Clips

How your movie transitions between clips helps determine its flow. For example,
upbeat, fast-paced music videos tend to have abrupt cuts between clips. By
contrast, videos for slow, dramatic songs tend to use transitions that slowly fade
one clip into the next.
iMovie HD comes with many transitions that you can easily add to your movie.
You can fade between clips, push one clip offscreen as the next clip appears,
and even add transitions between video clips and still images.

Adding Transitions Between Clips
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Adding Transitions Between Clips
Add transitions to your movie
Select a clip in the clip viewer. Make sure this clip is followed by at least one
other clip.
Click the Trans button, and then select a transition from the list. Notice a preview
of the transition appear at the top of the Transitions pane.

Drag the transition from the list to the right of the clip you selected. Notice the
small red line below the transition marker. This line appears while the transition is
being added between the two clips.

After the red line disappears, click the Rewind button to move the playhead to the
beginning of your movie, and then click the Play button to watch your movie.
Repeat the process to add several more transitions to your movie.
Save your iMovie project.

Adding Transitions Between Clips
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Adding Transitions Between Clips
Adjust a transition’s speed and other settings
You can adjust the speed of most transitions. For example, you can quickly fade between
two clips or, fade a clip in over several seconds. Use the Speed slider at the top of the
Transitions pane to adjust the timing, and then click the Update button. With the Push
transition, you can adjust where the clip comes from.
Transitions shorten your movie
Adding a transition between two clips combines part of each clip. For example, if you add
a two-second cross-dissolve, your movie will be shortened by two seconds. Make sure
you add your transitions before choosing music to match the length of your movie.
Fade in and out to black
There may be times in your movie when you want to show that you’ve switched to a
different location or time of day. A technique commonly used to achieve this goal is to
fade your video to, or from, black. Use the Speed slider to adjust the length of the fade,
and then drag the Fade In transition to the left of (or the Fade Out transition to the right
of) a clip in the clip viewer.
Use transitions to make your subject magically appear
You can use a dissolve transition between clips to have your subject appear, as if by
magic. For example, with your camera on a tripod, capture video of someone in a room.
Then stop recording and have the person leave the room. Without moving your camera
or tripod, capture more footage of the empty room. You can edit these clips together in
iMovie with a dissolve to have your subject appear or disappear from the scene!
Have your subject push the transition
If you film your subject appearing to push against a wall, you can use this footage in
combination with a Push effect so it appears that the subject is causing the video
transition to occur in your movie.
Applying a transition to multiple clips at once
If you want to apply the same transition between many clips, hold down the Shift or
Command key and then select multiple clips in the timeline. From the Transition pane,
choose a transition you want to use, and then click Apply. This adds the transition to all
of the selected clips.
Updating your transition settings
You can easily change the settings for transitions even after you’ve put them in your
movie. Just select the transition icon in the timeline and then change any settings you
want in the upper right corner of the iMovie Transitions window. When you’re ready, click
Update and your transition will change.
Adding Transitions Between Clips
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Adding Video Effects

iMovie HD comes with effects you can use to enhance your movie. For example,
you can change a clip so that it appears in black and white, or give it a sharp or
soft focus. When you’re feeling really creative, you can add effects such as rain,
fog, and even fairy dust!
Effects can be applied to both video clips and still images. You can apply effects
to one or all of your clips, and even apply multiple effects to the same clip.

Adding Video Effects
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Adding Video Effects
Practice adding effects to your clips
In the clip viewer, select a clip to apply an effect to.

Click the Effects button. Notice the list of available effects.
Click an effect to select it. Notice a preview of the effect appear at the top of the
Effects pane.

Click the Apply button to add the effect to the clip. A small red progress indicator
appears as the effect is added to the clip.
After the red line disappears, click Rewind to move to the beginning of your
movie, then click the Play to watch the movie.
Save your iMovie project.

Adding Video Effects
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Adding Video Effects
Apply an effect to part of a clip
There may be times when you want to apply an effect to only part of a clip. For example,
in a movie about your dog, you might want to use the earthquake effect only when your
dog walks across the floor. Use the crop markers, below the timeline in the Preview area,
to select part of the clip. Then select the effect you want to add, and click the Apply
button. The effect will be added to the selected portion of the clip.
Apply multiple effects to one clip
With iMovie, you can apply multiple effects to one clip. For example, you can give your
movie an older look by applying both the Sepia Tone and Aged Film effects. Select a clip
that already has an effect and apply another effect. The additional effects are permanent
only after you save your project or empty the iMovie Trash.
Apply one effect to multiple clips
There may be times when you want to apply one effect to multiple clips, such as
changing a series of clips to black and white. To do this, select the first clip in the series.
Then hold down the Command key and select every other clip in the series. Then click
Apply to apply the same effect to all the selected clips.
Look for effect-specific options
Some effects have additional options you can adjust. If available, these options appear
below the effects list. For example, with the Aged Film effect, you can adjust the amount
of jitters and scratches that appear onscreen. You can even set the amount of wind and
rain in your computer-generated storm.
Don’t overdo it with effects
Although effects can be a lot of fun, they can easily distract your audience from the
subject of your movie. When adding effects to your movie, think about the purpose of
each effect and whether applying it enhances or distracts from the story you’re trying to
tell.
Adding Video Effects
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Saving Your Movie Back to Video Tape

After you finish editing your movie, you’ll want to show it off on the big screen.
You can send the movie back to a tape in your video camera. This gives you a
high quality archive of your movie complete with transitions and your music.
Just put a new, recordable tape in your camcorder, place the camcorder in VTR
mode and connect it to your Mac via FireWire. You can watch it right on your
camcorder, or connect your camcorder to a television and let everyone watch.

Saving Your Movie Back to Video Tape
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Saving Your Movie Back to Video Tape
Save your movie to videotape
Insert a blank tape in your video camera and set it to VTR (or VCR) mode.
Attach your camera to your Mac with a FireWire cable.
With your completed project open in iMovie HD, go to the File menu and then
choose Share.
Click the Videocamera icon, and then set the number of seconds of black you
want before and after your movie.

When you’re ready, click Share. You movie will play in iMovie HD and you’ll also
be able to see it recording on the LCD panel of your video camera.
When the copy is complete, remove the tape from your video camera and set it in
“Safe” mode.

Saving Your Movie Back to Video Tape
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Saving Your Movie Back to Video Tape
Use new videotape when exporting your movie
It is a good idea to export your movie to a new digital videotape so that you don’t copy
over your original video footage. You never know when you might want to use footage
you didn’t use earlier. If you find yourself making short movies, consider creating a
master tape that contains all of your finished movies.
Lock your tape when finished
You can lock your videotape to prevent accidentally writing over important material. Just
flip the switch to the “save” position on the edge of your videotape and your material is
safe.
Share selected clips
You can archive just a few clips to videotape instead of your entire project. To do so,
select the clips from the iMovie HD timeline, go to the File menu and choose Share. Click
the “Share selected clips only” checkbox, and then click the Share button.
Add black to before or after your movie
Rather than showing your audience static before and after your movie, you can set
iMovie HD to record a few seconds of black at the beginning and end of your movie. This
will give your presentation a polished look. You’ll find this option in the Videocamera tab
of the Share panel. For High Definition movies, a minimum of 6 seconds of black is
recommended.
Saving Your Movie Back to Video Tape
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Sending Your Movie to iDVD

You’ve finished your movie and now you want to watch it on the big screen. The
best way to do this is to create a DVD disc that you can play in your DVD
player, or share with others.
iMovie HD sends your movie to iDVD, an application that helps design and burn
DVD discs. By adding themes, photos and additional movies, you can give your
DVD a professional, Hollywood quality look. Then, with the click of a button, you
can create a DVD disc.

Sending Your Movie to iDVD
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Sending Your Movie to iDVD
Send your movie to iDVD and choose a theme
Click the iDVD button in the iMovie window.
Click the Create an iDVD Project to send your movie to iDVD.
After iDVD opens, notice your movie appears in the iDVD window.
Click the Customize button to reveal the customize pane, and make sure the
Themes tab is selected.
Choose a theme and notice a preview of the theme appears in the iDVD window.
Click the Preview button to see how your DVD will look.
Click the Burn button, and then insert a blank DVD into your Mac.

Sending Your Movie to iDVD
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Sending Your Movie to iDVD
Adding chapter markers to your movie
By adding chapter markers to your movie, you can easily create scenes on your DVD.
Just move the playhead to where you want a new scene to begin, and then click the Add
Chapter button. You can add as many chapters as you like
Adding your movie to an existing iDVD project
When you have an iDVD project already open, you can easily add another movie to it. In
iDVD, go to the File menu, choose Import and then choose Video from the menu that
appears. Browse your hard disk for the movie you want to add, and then click Import.
Sending Your Movie to iDVD
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